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DXMR50-LB-2PA Programmable Logic Blocks

Chapter Contents
oo L= OO PURP PR OROPIIN 3
ST oL Ter1 o= (o] o LRSS TOPRPRRPPRNt 4

Chapter 1 Overview

Banner's DXMR50-LB-2PA Programmable Logic Block consolidates data from multiple sources to provide local data
processing and logic functionality to solve applications independent of a higher-level control system.

The DXMR50-LB-2PA has two input ports, a programming port, and an output port. Data is collected into the internal logic
controller to facilitate edge processing.

The programming port is a male M12 connection that also provides common power and ground to all M12 Modbus ports. Use
the programming port and the BWA-UCT-900 adapter cable to connect to a PC to use the DXMR50 Configuration Software to
configure the device.

DXMR50-LB input and output ports

Input port 1 Port 0

Input port 2 Output port

Program the DXMR50-LB-2PA's logic controller using action rules and the DXMR50 Configuration Software.

» Thresholds (IF/THEN/ELSE) with timers, minimum on/off time

» Math/logic rules (arithmetic and bitwise operators)

» Control logic (logical operators and SR/T/D/JK flip-flops)

» Copy and decoding rules

» Trending (multiple averaging filters)

» Tracking (counts, on/off times)

» Delays (On Delay, Off Delay, On One-Shot, Off One-Shot, Pulse Stretch On, Pulse Stretch Off, Totalizer On, Totalizer
Off)

» Scalers

Models

Series Style Inputs Outputs
DXMRS50 — — 2PA —
[
LB =Logicblock  2PA = Input Port 1 and 2: '"2P = Pin 2 Discrete PNP, Pin 4: Discrete PNP
Pin 2: Analog (selectable 0-10 V DC or 4-20 mA) Pl = Pin 2: Analog (4-20 mA), Pin 4: Discrete PNP

Pin 4: Discrete PNP PU = Pin 2: Analog (010 V/ DC), Pin 4: Discrete PNP

DXMR50-LB-2PA Ports
Port 2P Model Pl Model PU Model
Pin 1 and 3: Power
Port 0/Power
RTU server for configuration and register access
Continued on page 4
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DXMR50-LB-2PA Programmable Logic Blocks Overview
Continued from page 3
Port 2P Model Pl Model PU Model
Pin 1 and 3: Power
Input Port 1
Pin 2: Analog (selectable 0-10 V or 4-20 mA)
Input Port 2
Pin 4: Discrete PNP
Pin 2: Discrete PNP Pin 2: Analog (4-20 mA) Pin 2: Analog (0-10 V)
Output Port
Pin 4: Discrete PNP Pin 4: Discrete PNP Pin 4: Discrete PNP
Supply Voltage Connections
12V DCto 30V DC Three fixed nylon 5-pin M12 female quick disconnect
. connectors
Power Consumption o . .
400 mA maximum at 12 V DC One 5-pin nickel-plated brass M12 male quick disconnect
Supply Protection Circuitry Communication Hardware (RS-485)

Protected against reverse polarity and transient voltages

Application Notes
Applying greater than 30 V on the 10 pins may damage the
unit
When connecting external devices through the DXMR50, it is
important not to exceed the maximum current limitations of 4
Amps

Inputs
Sourcing discrete (PNP), 4-20 mA analog, 0-10 V analog
Accuracy + 0.5%
Resolution: 10-bit

Analog Input Impedance
Current model: Approximately 250 ohms
Voltage model: Approximately 14.3K ohms

Analog Outputs (DAC)

4 to 20 mA or 0 to 10 V DC output Accuracy: 0.1% of full scale
+0.01% per °C

Resolution: 12-bit

Discrete Input ON Condition
PNP: Greater than 7 V

Discrete Input OFF Condition
PNP: Less than 4 V

Discrete Output Load Rating

200 mA maximum current at 30 V DC
Construction

Connector Body: PVC translucent black
Indicators

Green: Modbus Communications

Amber: Discrete Input and Output Active Status

Green: Analog Input and Output Active Status

Interface: 2-wire half-duplex RS-485

Baud rates: 1.2K, 2.4K, 9.6k, 19.2k (default), 38.4k, 57.6K, or
115.2K

Data format: 8 data bits, no parity, 1 stop bit

Communication Protocol
Modbus® RTU

Environmental Ratings
For Indoor Use Only

IP65, IP67, NEMA 1, UL Type 1

Vibration and Mechanical Shock

Meets IEC 60068-2-6 requirements (Vibration: 10 Hz to 55
Hz, 1.0 mm amplitude, 5 minutes sweep, 30 minutes dwell)

Meets IEC 60068-2-27 requirements (Shock: 15G 11 ms
duration, half sine wave)

Operating Conditions
—40 °C to +70 °C (—40 °F to +158 °F)
90% at +70 °C maximum relative humidity (non-condensing)

Storage Temperature
—40 °C to +80 °C (—40 °F to +176 °F)

Certifications

Banner Engineering BV
Park Lane, Culliganlaan 2F bus 3
1831 Diegem, BELGIUM

l ' K Turck Banner LTD Blenheim House
Blenheim Court

C n Wickford, Essex SS11 8YT
GREAT BRITAIN

LISTED

FCC Part 15 Class A for Unintentional Radiators

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the

interference at his own expense.

(Part 15.21) Any changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate this

equipment.

Industry Canada ICES-003(A)

This device complies with CAN ICES-3 (A)/NMB-3(A). Operation is subject to the following two conditions: 1) This device may not cause harmful interference;
and 2) This device must accept any interference received, including interference that may cause undesired operation.
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Overview

DXMR50-LB-2PA Programmable Logic Blocks

Cet appareil est conforme a la norme NMB-3(A). Le fonctionnement est soumis aux deux conditions suivantes : (1) ce dispositif ne peut pas occasionner
d'interférences, et (2) il doit tolérer toute interférence, y compris celles susceptibles de provoquer un fonctionnement non souhaité du dispositif.

50 mm
[1.97"

M12x1

/ Female

Dimensions
All measurements are listed in millimeters [inches], unless noted otherwise. The measurements provided are subject to
change.
50 mm
(7] M12x1
25 mm Male
= 098] *‘ ‘
15 mm
Y (0597
25mm
[0.98"
M12x1 ¢ '{ ﬁ% 20 mm
Female —\ & [0.797]
C J
17 mm
—— o —-— @4.5mm
0671 [0.18"]
\ \
81.1mm
[3.197
e A
N
84.8 mm
[3.347]
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DXMR50-LB-2PA Programmable Logic Blocks
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Chapter 2 Configuration Instructions

Register Flow

The DXMR50-LB-2PA register data flows through the local registers, which are data storage elements within the processor.
Use the DXMR50-LB Logic Block Configuration Software to program the controller to move register data from the data store
registers to the 1/0O ports.

The DXMR50-LB-2PA moves and manipulates data using an on-board collection of uint32 registers referred to as data
stores. Each DXMR50-LB-2PA model has 20 general-purpose data stores that can be used in tandem with action rules to
transform data and achieve a wide range of logic operations.

Device-specific input and output data stores are also defined for each DXMR50-LB-2PA model; the logic established using
action rules should accept data from the input data store(s) and ultimately place the results in the output data store(s).

Input/output data stores
B R3O Configuration Software

File Trafic DXM Help Selected Model: DXMR50-LB-2PA-2P (110}

Data Name Constant Value Counter Rate Used in Read Rules Used in Write Rules Used in Action Rules 1D

Starting

Configuration PNP Discrete Out 1 Yes

PNP Discrete Out 2 Yes

Data Stores PNP Discrete In 1

PNP Discrete In 2

Action Rules Analon 4.20mAln 1

Analog 4-20mA In 2

1/0 Configuration
Data Store 1

Data Store 2
Dala Store 3
Data Store 4
Data Store 5
Dala Store 6
Dala Store 7
Data Store 8
Data Store §
Data Store 10

Data Store 11

Note: Users familiar with non-R50 DXM models may note that data stores behave much like the local registers configured on
those devices. Data stores serve as an abstraction for these registers, enforcing standards regarding register quantity and
use (input, output, or generic) for the DXMR50 device family.

02-Mar-26 © Banner Engineering Corp. All rights reserved. page 6 of 26
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Configuration Instructions DXMRS50-LB-2PA Programmable Logic Blocks

DXMR50 Configuration Software Overview

Use the DXMR50-LB Logic Block Configuration Software to customize your DXMR50-LB-2PA Programmable Logic Block
configuration and process data from the controller.

Download the latest version of all configuration software from www.bannerengineering.com. For detailed instructions on how
to program any DXMR50-LB Logic Block, download the configuration software manual, p/n 252379.

This configuration file defines parameters for the DXMR50-LB-2PA and saves the configuration in an XML file on the PC.
After the configuration file is saved, connect the DXMR50-LB-2PA to your PC using adapter cordset BWA-UCT-900 to upload
the XML configuration file to the DXMR50-LB-2PA for operation.

Use the configuration software either while connected to a DXM or as a standalone configuration software.

To detect the DXMR50-LB-2PA that you have connected to your PC using the BWA-UCT-900 adaptor, select Auto Detect to
load the Starting Configuration screen.

The top-level menus are similar to other Windows programs: File, Traffic, DXM, and Help.

» Use the File menu to manage the loading and saving of the XML configuration file created by the configuration
software.

» Use the Traffic menu to view data traffic on the serial bus.
» Use the DXM menu to send and retrieve XML configuration files to or from a connected DXM.
» Use the Help menu to load the configuration software instruction manual in your default PDF viewer.

Opening screen

R50 Configuration Software

Come Port C0MG f+)

PO ared Mandbus RTU

I
D&

Mesdibus BTU Onky
- -

v { awPapratens - i KT Onty [P el vine - V0 wed Mot ET

To create an XML file in offline mode (without a DXMR50-LB-2PA connected to the PC), select the Offline Configuration
options for DXMR50-2P series (I/O Only), the DXMR50-2M series (Modbus RTU Only), or the DXMR50-MPA series (I/O and
Modbus RTU)

Save and Upload the Configuration File

After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the software and before
sending the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving
the configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File » Save As menu.
2. Go to the DXM » Send XML Configuration to DXM menu.

Status indicator bar

Connected DXMRS50 at COMS ORLogicstxmi Application Status I

o If the Application Status indicator is red, close and restart the DXMR50-LB Logic Block Configuration
Software, unplug and re-plug in the cable and reconnect the DXM to the software.

o If the Application Status indicator is green, the file upload is complete.
o |If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.
After the file transfer is complete, the device reboots and begins running the new configuration.

02-Mar-26 © Banner Engineering Corp. All rights reserved. page 7 of 26
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DXMR50-LB-2PA Programmable Logic Blocks Configuration Instructions

Starting Configuration

Use the Starting Configuration screen to download the active configuration from the connected DXM or to start a new
configuration.

Starting Configuration screen

[ RS0 Configuration Software

File Trafic DXM Help Selected Model: DXMR50-LB-2PA-2P (1/0)
Starting
Configuration Select a Configurafion Template: (Blank R50-LB-2PA-2P - Current ~
Downioad Gonfiguration from DXM
Load Selected Tempiate
Data Stores OR

c DXM. 0 & save location, the

tknioaed o mton e it he lowed ik e spokcolin 10 Configuration rules for reacliniting R50-LE-2PA-2P mode, 2 PNP discrete inputs, 2 |~
analog inputs configured as 4-20mA and 2 discrefe oufputs.

Action Rules No acion rules -

1/0 Configuration

To start a new configuration, select a stock template from the drop-down list and select Load Selected Template. A
description of the selected stock template is displayed below these controls. This option provides preloaded |0-Configuration
rules to read/write the specific DXMR50 model you have selected and automatically assigns data store names.

Data Stores

Use the Data Stores screen to view a list of defined registers or to make changes to registers and show where the register is
used in the defined configuration.

Data Stores screen
BB Rs0 Configuration Software

File Trafic DXM Help Selected Model: DXMR50-LB-2PA-2P (70}

Data Name Conslant Value Counter Rate Used in Read Rules Used in Write Rules Used in Aclion Rules 1D

Starting

Configuration PNP Discrete Out 1 Yes

PNP Discrete Out 2 e

Data Stores PNP Discrete In 1
PNP Discrete In 2
Action Rules Analog 4-20mA In 1
Analog 4-20mAIn 2
11O Configuration
Data Store 1
Data Store 2
Data Store 3
Data Store 4
Data Store 5
Data Store 6
Data Store 7
Data Store 8
Data Store 9
Data Siore 10
Data Store 11

Data Slore 12

Select a Data Sfore on the fable above to edit its parameters.

The Edit Data Store tab presents all the parameters for a single register. Select the register to modify using your keyboard's
arrow keys or by clicking within the corresponding row in the Data Stores table. Use this section to assign the register a
name, value type, or scaling. The value type and scaling options are drop-down lists.

page 8 of 26 © Banner Engineering Corp. All rights reserved. 02-Mar-26
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Configuration Instructions DXMR50-LB-2PA Programmable Logic Blocks

Value

Edit Data Store tab

Ediit Dt Stewe

None. The register has a value of 0 by default and can be modified by any source that has permission to set register
values.

Constant. Forces the register to be set to the specified value. Used to compare values when using action rules. Constant
values cannot be overwritten by any source that would normally have permissions to modify register values.

Counter. The value increments with the specified frequency (every 100 ms or every 1 second). Write to the data store
registers to start the timer at a specific value.

Scaling

The scaling parameter changes the viewing of register data.

Scaling first applies a scale (add, subtract, multiple, divide, or modulo (remainder in division)), then adds an offset value.
Select Apply offset before scale value to add the offset first and then apply the scale.

Action Rules

Action rules perform simple logic functions and manipulation of data store register data.

Action rule processing is autonomous from other data store functions.

Action Rules screen

Nachd Mol (XU L S, Y

- Seeacie | Chee Reecedin  Ousle Semomd R
B (N T (B GRS O VWL B L H R O R SR RRTAAE F T T ms R (s (] e e R (6 B S

- s
Sy - - A Cae e 5 ST
ST ———

Control Logic rules are binary rules, with the results being either 0 or 1

Decoder rules copy a subset of the bits in one register to a specified bit index within another register
Delay rules allow for time-based logic between source and destination registers

Math/Logic rules deal with 32-bit register logic with results from 0 to 4,294,967,295

Register Copy rules copy the contents of one register to another

Scaler rules transform the domain of register values between source and destination registers
Threshold rules create event-driven conditions

Tracker rules monitor a register value and store the result of a function in another register

Trending rules find average, minimum, and maximum values

Each action rule is processed in order, similar to the read/write rules. The groups of action rules are solved in the following

order:

O O~ WODN -

. Calculate (Math), continually processed

. Copy rules, processed only when a change of state is detected on the source register
. Threshold rules, continually processed

. Control Logic, continually processed

. Trending, continually processed

. Trackers, continually processed.

02-Mar-26 © Banner Engineering Corp. All rights reserved. page 9 of 26
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DXMR50-LB-2PA Programmable Logic Blocks Configuration Instructions

All Action Rules also have Clone Selected Rule or Delete Selected Rule commands to quickly copy/paste or delete the
selected rule.

Threshold Rules

A threshold rule triggers event messages to be sent to the cloud (event-driven push), pushes events to be stored to the local
event log, and creates a standard push message to send all defined registers to the cloud.

A threshold rule creates a simple IF-THEN-ELSE comparison for a register to determine its value and set another register to
indicate if the rule is true or false. Note that you must select a true option to set a false option. The definition section of the
threshold rule sets the comparison and values. The definitions of the threshold rules can also be defined by the optional
parameters, Hysteresis, On Time, and Logging options.

If selected, the false option (else condition) is applied. This creates an IF-THEN-ELSE structure. To remove the ELSE
condition, deselect the false option or set the result register to itself.

Threshold Rules

Saecned Mool CMSSD LI J0A-2P Oy

= A dchon Pl St ool Fus Canaa Sgrwaraad Fraby
Shoow Al Riben | | Hinks A Biges|  [5] Show Tareshold Figien (] Shom Copy Buies (K] Sow Wit Logic Rt [3] Saow Control Rgley (5] Sape Toand Riyies  [5 Show Trackes Rins (3] Soow Dn

s Trwi e ke W vl Dala Si0s 1 eaea 0

e v W D T = - Ly Teymireee wnie bk R T

Achon Rubes

L e emy G000 00 = ||| e fee ke e e e
| [P ——— - v on tie S :
n et

Whee wpiop 1 Date Saene i ot egual b B T o I TG | 000 S

TR |

1. Write the threshold rule as a sentence.
2. Select the data store register, operator, and value from the drop-down lists.
3. Define the value of the register when the statement is true and when it is false.

Value/Register
When Value is selected, provide a fixed number in the following entry box.
When Register is selected, provide a data store register address in the following entry box.
The contents of the data store register are used in the threshold rule. When Same as Source is selected (else
statement), the contents of the register defined in the If comparison is used as the result.

Hysteresis

Hysteresis is an optional parameter that is enabled only when values are non-zero. How hysteresis is applied depends
on the comparison.

For a test that becomes true if greater than, the test will not return to false until the register is less than the test value by a
margin of at least this hysteresis value.

If a test becomes true if less than, the test will not return to false until the register is greater than the test value by a
margin of at least this hysteresis value.

Minimum On Time and Minimum Off Time are time-based parameters that govern how long a statement must be true or
false to activate the output register.

On Time

Selecting On Time stores in a register how long (in minutes) the threshold rule has been true.

The On-Time value is shown in the data store register in minutes but maintains the internal counter in seconds. This
results in the accuracy of seconds, not rounding of the value stored in the register.

page 10 of 26 © Banner Engineering Corp. All rights reserved. 02-Mar-26
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Configuration Instructions DXMR50-LB-2PA Programmable Logic Blocks

Register Copy Rules

Use the Register Copy screen to copy one data store register into another data store register.

Register Copy screen
File Trafic DXM Help Selected Model: DXMR50-LB-2PA-2P (10}
Starting |Register Copy | = | | Add Action Rule| | Clone Selected Rule| | Delete Selected Rule |

Configuration

| Show All Rules | | Hide All Rules |  [%] Shew Threshold Rules  [X] Show Copy Rules %] Show Math,

Data Stores Analog In Copy value in | Analog 4-20mAiIn1 ~  to Data Store 4 b

Action Rules

Math and Logic Rules

Math and logic rules deal with 32-bit register logic. In contrast, control logic rules are binary rules, with the results being either
Oor1.

Math and Logic Rules screen
BB P50 Configuration Setmars
Fila  Tiaffic DOOW  Halg i) WA . DR L B PR ol

Starling Ml Logr v (A0 Arkon Fle | sk S0 Fuk | Dul Seecid us
Configuration
| BhowAl Rues| Ml Ad Rutes | (] Show Thopshotd Ryler [ S Cogy Fufe. (3] St Mt f Lagic Risen [ Show Cortrol Rybes (5} Show Tend Rl [ Saom Teacker Faes 3] 5

[t Shores Fiper rrath nibe [ = Umevl i - Seed el e | — e - L TR T —
i gk
B

Achion Rules. rr
s
peerm

. Logics O

i1 Condguraon Lingest NOR

Ligicial A0

The average, sum, and logic operations are valid for ranges of registers. The data store registers are unsigned 32-bit
integers. All math and logic functions can operate on all 32-bits.

The data store register operations are:

» Add. Adds two data store registers and stores the result in a data store register.

» Average. Averages the values of multiple registers and stores the result.

» Divide. Divides data register 1 by data store register 2 and stores the result. Dividing by zero results in a zero.

* Logic NOT. Performs a bit-wise one's complement on a register and stores the resuilt.

» Logic OR, AND, NOR, NAND, XOR. Performs bit-wise logic functions on multiple registers and stores the result. Bit-
wise logic functions operate on all 32-bits of the registers. To perform a logic function on a simple 0 or 1 in the
registers, use the control logic rules.

* Multiply. Multiplies one register by another and stores the result.
» Sum. Adds multiple registers and stores the result in a data store register.

» Subtract. Subtracts register 2 from register 1 and stores the result. For negative numbers, the results are in two's
complement form.

Control Logic Rules

Control logic rules are binary rules, with the results either 0 or 1.

Some control logic rules create memory elements using the data store registers as inputs and outputs. A value of zero in a
register is defined as 0 in the control logic rule, and a non-zero value in a register is defined as a 1 value. Control logic rules
are evaluated when an input value changes state.

Memory elements include J-K Flip/Flop, S/R Flip/Flop, D Flip/Flop, and T Flip/ Flop.

02-Mar-26 © Banner Engineering Corp. All rights reserved. page 11 of 26
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DXMR50-LB-2PA Programmable Logic Blocks Configuration Instructions

Control Logic Rules screen
[ e
Fie  Toific DoO8 sl Satechid Modsl CIOMLE LB J0R P 0

= | A A P || o Sl P | D St s |

Stariing Lo
o Rgpanstion

.nu Buber  buig Al Rigen | (W] Sroe Treesnoid Ragen (1] e Copy Fuies  [B] Show Wei | Lager s [ Snoe Contiol Ruter  [] Saos Treed Ratos (B Soow Teaooe Buser (W) S [

Data Stores Ve cotirnan | Gt [T | by ' Wn Cupa @ PRP Duow dut
- AND
R

wOT
MasD
MNOR
V0 Condguration u’:::, :’:'
T i P
X Fig Fiog
Control Logic
Control Logic
Function In1 In2 Q out
0 0 0
1 0 0
AND
0 1 0
1 1 1
0 0 0
1 0 1
OR
0 1 1
1 1 1
0 0 0
1 0 1
XOR
0 1 1
1 1 0
0 - 1
NOT
1 B, 0
0 0 1
1 0 1
NAND
0 1 1
1 1 0
0 0 1
1 0 0
NOR
0 1 0
1 1 0
NOTE: * Output Qn is an inverted output from the Q output and represents optional inputs or outputs.
Leave the optional inputs or outputs connected to 0 when not used.
J-K Flip/Flop

If J and K are different, the output Q takes the value of J. The Enable, Clock, and Qn connections are not required for
operation.
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J-K Flip/Flop
*Enable J K * Clock Q Qn*
0 X X X No change No change
1 X X Oortor| No change No change
1 0 0 1 No change No change
1 1 0 1 1 0
1 0 1 1 0 1
1 1 1 T No change No change

If an input is zero it is false (0), and if a value is non-zero (anything but zero) it is considered true (1). All but one requires two
inputs; the NOT rule only has one input. Some of the control logic rules provide basic non-memory logic functions: AND, OR,
XOR, NOT, NAND and NOR. These basic logic functions are based on zero and non-zero values and resultin a 0 or 1.

Optionally, the rules can have a Clock input and an Enable input. The Clock input determines the time (0-1 rising edge) the
rule is evaluated. The Enable input enables or disables the logic function.

* AND—Output is high (1) only if both inputs are non-zero

* OR—Output is high (1) if either input is non-zero

» XOR—Output is high (1) if either, but not both, inputs are non-zero

* NOT—Input is inverted to the output

* NAND—Output is low (0) if both inputs are high (> 0)

* NOR—Output is high (1) if both inputs are zero (0)

Set/Reset (S/R) Flip/Flop

The Set/Reset Flip/Flop, or S/R Latch, is the most basic memory device. The S input sets the output to 1, and the R input
sets the output to 0. Selecting Insert input turns the inputs to low active, so a 0 on the S input set the Q output to 1. The truth
table below is defined without the invert flag.

Set/Reset (S/R) Flip/Flop

S R Q Qn*

1 0 1 0

0 0 No change No change
0 1 0 1

1 1 Invalid ("

Delay (D) Flip/Flop

The Delay (D) Flip/Flop takes the D input to the outputs at the next rising edge of the clock. All other states of clock have no
effect on the outputs. The Enable input is optional. A Clock input and a D input changing at the same time results in an
undetermined state.

Invert Inputs—Typically a input value of "1" will be evaluated as true (active), selecting "Invert inputs" will result in a "0" value
to be considered true(active).

Flip/Flop is R dominated—xxx

Table references:
» X =doesn't matter what the value is.
» <up arrow>, <down arrow> = signify a rising or falling edge of the clock input.
» * = optional input or output

™ The Set input and Reset input active at the same time is an illegal condition and should not be used.
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Delay (D) Flip/Flop
*Enable D Clock Q Qn*
0 X X No change No change
1 X Oor1tor| No change No change
1 0 1 0 1
1 1 1 1 0

Toggle (T) Flip/Flop
The Toggle (T) Flip/Flop toggles the state of the output if the input is 1. The Enable input is optional. A Clock input and a T
input changing at the same time results in an undetermined state.

Toggle (T) Flip/Flop
*Enable T Clock Q Qn*
0 X X No change No change
1 X Oortor| No change No change
1 0 1 0 1
1 1 i (toggle) (toggle)

Trending and Filtering Rules

Use Trending rules to find the average, minimum, and maximum values for a specific register at a user-specified time
interval. The Trend function collects data when the device boots up and accumulates the average, minimum, and maximum
values for a register.

Local registers locations are defined include: Register to Track, Filter Register, Average Value Register, Minimum Value
Register, Maximum Value Register, and Enable Register. When not using the local register definitions, leave them set to zero.

The filter and tracking is applied according to this flowchart.

Sample
Interval
Enable
Register
] Avg Register
Register InpUt Trendmg Min Register

to Track Filter Engine

Max Register

Input Filter Input Filter Reset
Window Register

The trending rule has an optional filter input, and the filter output is the input to the trending operation. The filter result is used
before applying the trending rule when you define the Filter parameter. The other trending parameters are listed. The
Average, Minimum, and Maximum register fields are optional and can be left set to zero when using the Filter output register.

Register to Track

Local register to provide the input to the filter and trending rule.
Sample Interval

Defines the time interval of the samples to collect from the register.
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Filter
Defines the specific filter algorithm to apply to the front end of the trending rule.

Cumulative Average. Sums the samples and divides them by the number of samples.

Exponential Moving Average. A moving average filter that applies weighting factors that decrease exponentially. The
weighting for each older sample decreases exponentially, never reaching zero.

Lulu Smoother. Takes the minimum and maximum values of mini sequences of sample points. The mini-sequence
length is defined by the filter window parameter.

Median Average. Takes a least three sample points, sorts the sample points numerically, and selects the middle value
as the result. A new sample point entered into the filter removes the oldest sample point.

Recursive Filter. Created from a percentage of the current sample plus a percentage of past samples. The number of
samples is determined by the Filter Window parameter.

Simple Moving Average. Takes the number of samples defined by the Filter Window parameter and averages the
samples for the result. When a new sample is taken, it becomes the latest sample point, and the oldest sample point
is taken out of the filter averaging.

Weighted Moving Average. A moving average filter that applies a weighting factor to the data based on when the data
was captured. More recent data has a higher weighted factor.

Filter Window
Defines the number of samples for a filter algorithm. For example, if the sample interval is 5 minutes and the Filter
Window is 100, this creates a 100-point moving average over a 500-minute time period.
Filter Register
The local register that stores the output of the first-stage filter. This is not required to connect the filter front-end to the
trending rule processing.
Average Value Register
The local register number to store the average value of the trending rule. The average is calculated from the beginning of
the power-up or from the Reset Trending time. (Hourly, Daily) Defining this local register is optional and can be left at
zero.
Minimum Value Register
The local register number to store the minimum value of the trending rule. The minimum is captured from the beginning
of power-up or from the Reset Trending time. (Hourly, Daily) Defining this local register is optional and can be left at zero.
Maximum Value Register
The local register number to store the maximum value of the trending rule. The maximum is captured from the beginning
of power-up or from the Reset Trending time. (Hourly, Daily) Defining this local register is optional and can be left at zero.
Reset Trend Data
Use to reset the trend data accumulation. (Hourly, Daily, or not at all)

Enable Register

The Enable Register is an optional register and can be left set to zero. The Enable Register defines the address of a
local register that can be used to turn on and off the trending function. Set the register value to 1 to turn on trending or to
zero to turn off trending. When disabled, the current data is held until the rule is enabled again.

Tracker Rules
Tracker rules monitor a data store register and store the result of a function in another register.

Tracker Rules screen

e b WGl [EEMLSO LI PR, 8 0

= el ki ol Choie Seadhil Faw | Dl Sl Faki
Wt A Mkee | | SIS MulgE | (W Onder Terpshind Mulsd (W) 9% Copy R e Sheer AR ILSGPE Ml (w0 Coee Mot o DR TTENI MkRE (W] e Teacar sy o) 98w

[ Soursn e Brkeh | F0° Dnscta i 1 remsten i e sl Desinabon  Dals i &

Achion Rules

The possible functions are:

» Rising Edge. Counts the number of register transitions from 0 to non-zero value. The speed at which it can count
depends on how much work the DXM is performing. Typical tracker rates should be around one to two times per
second.

* On time in ms. Tracks the time (ms) that the register is in the non-zero state

» Off time in ms. Tracks the time (ms) that the register is in the zero state
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Decoder Rules
Use the Decoders screen to copy a subset of the bits contained in a data store register location into another register.

Decoder Rules screen

o i (LR 4 S Y

o e M Clir e P i et

Add Decoder Rule Starting at bit index

Click to create a new decoder rule. The specified number of bits will be copied from the source
register ascending from the specified index (minimum of 0,

Name maximum of 31). Starting at bit O will capture the lowest-order
Name your rule. portion of the register's value, while starting at index 31 will
Copy from Source Register copy only the highest-order bit.
The register to copy data from. Destination Register
Number of bits The register to copy data to.
The total number of bits (minimum of 1, maximum of 32) to Starting at bit index
copy from the source register. The lowest-order bit of the data copied from the source
The Number of bits field auto-decrements when either of the register will occupy this bit index in the destination register.

Starting at bit index fields is increased to ensure that the
number of bits copied does not overflow the maximum bit
index of 31.

On the DXMR50-LB-2PA, these rules are executed by performing a bit shift, applying a mask, and writing the result to the
destination register.

Delay and Scaler Rules

Delay rules allow for time-based logic between source and destination registers.

Scaler rules transform the domain of register values between source and destination registers.

|O Configuration

Go to the 10 Configuration tab to define read rules, write rules, and the Modbus settings.

Both the Read Rules and Write Rules screens include a Show Internal Rules checkbox. These internal rules load with your
starting configuration files and are default rules specific to the discrete/analog inputs and outputs. When the checkbox is not
selected, the rules are hidden from view. For normal operation, the internal rules do not need to be changed.

Modbus Settings

Use the I/O Configuration » Modbus Settings screen to view and configure the DXMR50 server settings. Select the Get and
Set buttons to view and adjust these settings.

Baud Rate Parity
Defined for both the Modbus client and server Defined for both the Modbus client and server
Settings include: 19200 (default), 1200, 2400, 9600, 38400, Settings include: None (default), odd, even, space, and mark

57600, and 115200 Internal Server ID

The internal server ID is the Modbus ID that an external
Modbus client accesses to read/write to the local registers on
the DXMR50
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. R50 Configuration Software

File Traffic DXM Help Selected Model: DXMR50-LB-2PA-2P (I/O)

EEEL R RN | Modbus Settings

Starting
Configuration
DXMR50 Server

Baud rate |19200 X Pa MNone X
Data Stores =
Internal Server 1D | 0¥ |eer| | ser

Action Rules

11O Configuration

Advanced Tab

Access the Configuration Description, Read/Writer Register Values, and Reprogram screens from the Advanced tab.

Configuration Description
Use the Configuration Description screen to set and save the Configuration Title and Configuration Details.

Starting Configuration Description | Rafs=1 Wy Rl @ ETTEA Bt E=1)]
Configuration
Configuration Titke

|'E1aﬁ'k"ﬁs'6}|3

Data Stores

Configuration Details

Action Rules
10 Configuration nules for réadiwriting RS0 2P model, 2 PNP discrete inputs, 2 anabpg inputs conhigured as
4-20mA and 2 discrete outpuls.

Mo action niles

WO Configuration

Total characters usad: 167 / 4096
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Read/Write Register Values

The Register View screen is a Modbus utility to help debug configurations and view register data for devices connected to the
DXMR50.

Confiquration Dascription JESERTVINEEL IR Reprogram
Fnadivrie Souce snd Formal

Data Formad [Decimal = | PFegster source |Data Stores = | Addess | 159 Tmect 5 HHwec

(] Sew el iwgmiter narman (] Agedy nign and regner ealing b valuen

| [] 1= |1 ]
e 2 PP Descowin Out | G clrgiviars 3 PP Dacrete Oull [0
n@ [ ] ul |[* o
4 PP Discrele DutZ | 0 4 ]
(B g Saenor ingad 1| 0 s eoment] 1y 1@
[} Sermax gt 3| 0 & (]

(] Enstie Poang [~
. 7 ] T n
o [] Anslog H-2mA R |0 ¥ Anog d-20ma 1 [0
1 [ " o
10 [] 10 0
1 Anaiog 4-20mAIn 2| 0 n Anaog &-20mA N 2 [0
12 o 12 o
1 [ 13 o

Follow these steps to select the registers to view:
1. Connect to the DXMR50-LB-2PA using the BWA-UCT-900 adaptor.
2. From the Register source drop-down list, select between Remote Device, Data Stores, or DXM inputs/outputs.
3. Enter a Modbus ID when accessing remote devices.
4. Select the Starting Register to display.
5. Select the number of registers to display.

To read the contents of a specific register or range of registers:
1. Select the starting register.
. Select the number of registers to read from.
. Click Read Registers to read the data once. The register values display in the Read Registers section.
. Select Enable Polling.
. Specify a polling rate.
. Click Read Registers to create a constant polling loop.

D b~ ON

To write values to a specific register or range of registers:

1. Select the starting register.

2. Select the number of registers to write to.

3. Enter the value to write to these registers.

4. Click Write Registers to send these defined values to the selected registers.

Reprogram
Use the Reprogram screen to update the DXM's firmware.

Click Get Device Information to have the DXM read and display its serial number, model number, version, and firmware
numbers.

To reprogram the DXM, follow these instructions:

1. Connect the DXM to your PC using the BWA-UCT-900 adaptor cordset.
2. Go to the Advanced » Reprogram screen.

3. Click Select upgrade file.

4. Browse to the firmware HEX file location and select the file.
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BB 750 Configuration Software - [u] *

Fia Traffic OXM Help Selecied Model: DXMRS0-LE-2PA-ZP (1/0)

Configurabion Descripbon | ReadWrie Register Values

Data Stores | |

Action Rules

110 Configuration
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Chapter 3 Installation Instructions

Mechanical Installation

Install the DXMR50-LB-2PA to allow access for functional checks, maintenance, and service or replacement. Do not install
the DXMR50-LB-2PA in such a way to allow for intentional defeat.

Fasteners must be of sufficient strength to guard against breakage. The use of permanent fasteners or locking hardware is
recommended to prevent the loosening or displacement of the device. The mounting hole (4.5 mm) in the DXMR50-LB-2PA
accepts M4 (#8) hardware.

See the figure below to help in determining the minimum screw length.

L,..-..: A
£ i [180mm
R 4
HEEEE S
IR 20
ol b >
3 mm
MOUNTING Manmuad
NUT * "
SURFACE * for minimum
engagement of
Screw Length = 18.0 mm + “X” mm + 3 mm three threads

CAUTION: Do not overtighten the DXMR50-LB-2PA's mounting screw during installation. Overtightening
A can affect the performance of the DXMR50-LB-2PA.
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Chapter 4 Modbus Overview

The DXMRS50 Series Logic Blocks use internal 32-bit registers to store information. The processor's internal Local Registers
serve as the main global pool of registers and are used as the common data exchange mechanism. External Modbus device
registers can be read into the Local Registers or written from the local data registers.

The DXMRS50 Series, as a Modbus client or server device, exchanges data using the Local Registers.
Using Action, Read/Write, and Threshold Rules allows you to manipulate the processor's Local Registers. The processor's
Local Registers are divided into three different types: integer, floating point, and non-volatile. When using Local Registers

internally, the user can store 32-bit numbers. Using Local Registers with external Modbus devices follows the Modbus
standard of a 16-bit holding register. Local Registers are accessible as Modbus ID 199.

DXMRS50 Logic Block

DXMRS&0 Logic Block

4 N

Port O =${ Power/Comms

Port 1 ———r=bla DXMR50 output
(D203 [—>| DataStore (ID 199) feep! Block » Output
Control Logic (ID 203) Port

- J

DXMR50-LB-2PA Modbus Server IDs and Ports

The DXMRS50 Logic Block Series may have up to two internal Modbus server addresses:

Internal Modbus IDs (factory default)

Modbus ID Device
199 Local Registers. Internal storage registers
203 LED Indicators

All Modbus registers are defined as 16-bit Modbus Holding Registers. The local register ID (199) is fixed for access. When
accessing the Local Registers through an external Modbus RTU Client, use the male M12 (comms) port.

The Server Port ID can be changed using the DXMR50 Configuration Software. Connected Modbus server devices can use
any Modbus ID.
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Port 0 Signals (Comms)
Name Port
Power (+) 0
RS-485+ 0
Ground (-) 0
RS485- 0

Input Port 1 and 2 Signals for models DXMR50-LB-2PA-2P/Pl/PU

Name Port Pin
Power (+) 1 1
Analog In 1 2
Ground (-) 1 3
|13NP Discrete IN 1 4
Power (+) 2 1
Analog In 2 2
Ground (-) 2 3
PNP Discrete IN 2 4

2

* Depend on the user's configuration.

Wire Color

Brown

White

Blue

Black

Brown

White

Blue

Black

QOutput Connections for models DXMR50-LB-2PA-Pl/PU

Data Store (ID
199) Register

13

Output Connections for models DXMR50-LB-2PA-2P

Data Store (ID
199) Register
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Voltage

Current

PNP Discrete
OuUT 1

PNP Discrete
OuUT 1

PNP Discrete
OuT 2

Write Rule

->

->

->

Write Rule

->

->

10 Block (ID 203)
Register

13
14

10 Block (ID 203)
Register

Out

Out

Out

Out

Out

Out

Out

Out

Pin
1
2
3
4
10 Block (ID 203)
Register
Voltage* 7
Current® 8
5
Voltage * 10
Current® 1
6
Port Pin
1
2
3
4
Port Pin
1
2
3
4

© Banner Engineering Corp. All rights reserved.
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Modbus Overview

Wire Color
Brown
White
Blue
Black
Data Store (ID
Roadpe 199) Register
> 7
> 8
5
10
11
6
Wire Color Name
Brown Power (+)
White Analog Out
Blue Ground (-)
PNP Discrete
Black oUT 1
Wire Color Name
Brown Power (+)
. PNP Discrete
White oUT1
Blue Ground (-)
Black PNP Discrete

OouT 2
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Brackets ...
Cordsets

Chapter 5 Accessories

Brackets

SMBR50
* R50 flat mount bracket
e M4 x0.7mm
* CAD Files: DXF, PDF, IGS, STP

4-Pin M12 Female RS-485 to USB Adapter Cordset, with Wall Plug
Model Length Style Product Image Pinout (Female)
2 4
BWA-UCT-900 1m (3.28 t) Straight < 1 3
\ - 1= Brown
_ Y 2 = White
3 =Blue
4 = Black
4-pin A-Code Double-Ended M12 Female to M12 Male Cordsets (datasheet p/n 236186)
Model Length Dimensions (mm) Pinouts
BC-M12F4-M12M4-22-1 1 m (3.28 ft) Female
R
BC-M12F4-M12M4-22-2 2 m (6.56 ft) [
5\— 1=Brown
BC-M12F4-M12M4-22-3 3m (9.84 ft) 403 % z ‘é\{ﬂge
0145057 4 = Black
BC-M12F4-M12M4-224 4m(13.12 ft) -
“Tp. Male 5 = Unused
BC-M12F4-M12M4-22-5 5m (16.4 ft)
| 2\"\/1 cus
BC-M12F4-M12M4-22-10 10 m (30.81 ft) v ( e o ) LISTED
014.5[0.57" e o
BC-M12F4-M12M4-22-15 15 m (49.2 ft) 3/V\4
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Model

BC-M12F4-M12M4A-22-1
BC-M12F4-M12M4A-22-2
BC-M12F4-M12M4A-22-5
BC-M12F4-M12M4A-22-8
BC-M12F4-M12M4A-22-10

BC-M12F4-M12M4A-22-15

Model

BC-M12F4A-M12M4A-22-0.3
BC-M12F4A-M12M4A-22-1
BC-M12F4A-M12M4A-22-2
BC-M12F4A-M12M4A-22-5
BC-M12F4A-M12M4A-22-8
BC-M12F4A-M12M4A-22-10

BC-M12F4A-M12M4A-22-15
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Length
1 m (3.28 ft)
2 m (6.56 ft)
5m (16.4 ft)
8m (26.25 ft)
10 m (30.81 ft)

15 m (49.2 ft)

Length
0.3m(1ft)
1 m (3.28 ft)
2 m (6.56 ft)
5m (16.4 ft)
8 m (26.25 ft)
10 m (30.81 ft)

15 m (49.2 ft)

M12x 1
014.5[0.57"]

=—32 Typ-

Dimensions (mm)

Dimensions (mm)

31 Typ.

© Banner Engineering Corp. All rights reserved.
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4-pin A-Code Double-Ended M12 Female to M12 Male Right-Angle Cordsets (datasheet p/n 236186)

Pinouts
Female
1/\/—\/)2
[
403
Male
2{'\.71
/Q .\

= 4

3

4-pin A-Code Double-Ended M12 Female Right-Angle to M12 Male Right-Angle Cordsets (datasheet p/n 236186)

Pinouts

Female
1/\/\/2
5 LB
403
Male

2 V.

)

g S &

Accessories

1 = Brown
2 = White
3 =Blue

4 = Black
5 = Unused

GUS

LISTED

1 = Brown
2 = White
3 = Blue

4 = Black
5 = Unused

GUS

LISTED
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Chapter 6 Product Support and Maintenance

Repairs

Contact Banner Engineering for troubleshooting of this device. Do not attempt any repairs to this Banner device; it contains
no field-replaceable parts or components. If the device, device part, or device component is determined to be defective by a
Banner Applications Engineer, they will advise you of Banner's RMA (Return Merchandise Authorization) procedure.

IMPORTANT: If instructed to return the device, pack it with care. Damage that occurs in return shipping is
not covered by warranty.

Contact Us

Banner Engineering Corp. | 9714 Tenth Avenue North | Plymouth, MN 55441, USA | Phone: + 1 888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.

Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner
Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been
defective during the warranty period. This warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner
product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF
PERFORMANCE, COURSE OF DEALING OR TRADE USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING
CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY
INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE
PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any
product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for
personal protection applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product
without prior express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change;
Banner reserves the right to modify product specifications or update documentation at any time. Specifications and product information in English supersede that
which is provided in any other language. For the most recent version of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.
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